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THE APPLICATION OF INSTRUCTIONAL TOOLS OF
HOME ECONOMICS TO ENHANCE PROBLEM SOLVING SKILLS OF
STUDENTS OF HOME ECONOMICS DEPARTMENT

Abstract: The main purpose of education is to help students leam in a way that
allows them to use what they have learned in solving problems in new situations.
Problem solving is the basis for educanon; therefore lecturers are expectad to
develop students' ability to solve problems. The study mimed to describe: (1) the
workability of the courseplan of Home Economics applying learmng models for
solving problems, (2) students activity during the learning, and (3) the problem
solving skills after the learning process The study employed descriptive method
What to implement in the study was therefore the instructional toolkit to boost the
problem solving skills of students. It was conducted at the Department of Home-
Economics, The State Umiversity of Surabava (Unesa), with 67 students
participating in the study. The research mstruments mcluded course plan
workability sheet;, obsenation sheet of leamning activities, and test. The collected
data were analyzed vsing descriptive qualitative and quantitative analyses. The
results shawed' (1) all leaming activities in the course plan were implemented
and categonized as “very good”, except the student presentations fit into the
category of "good”, (2) the student activities included team-working, contnbuting
ideas, being responsible, and caring were increased by N-gains; 0.70, 0.67, 0.58,
and 0,65, and (3) the implementation of the tools could enhance the problem
solving skills of students that involved understanding the problem, planning how
to solve problems, planning to implement problem-solving, and reflecting on the
results of solving the problem with the N-gains: 0,764, 0627, 0.580; 0.707.The
conclusion is that the adopuion of the lesson-planning tools can improve the
prablem solving skills of students.

Keywords: Education, Home Economics, Best Practice, Curriculum

Introduction

Thiking is in fact a cognitive process. It 15 an active mental process to
pequire knowledge (Costa, 1985). Thinking 15 a process to manage and transform
the information in the memory (Santrock, 2008 357). Thinking activities mclude
fornung concepts, reasoning, crbical thinking, decision making, creative thinking,
and problem solving
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The problem occurs if there 1s a gap between one's reality and expeciation,
and he or she cannot find & way to solve it The general steps to be taken to solve
problems are: 1) identifying and defining the problem, 2) developing problem-
solving strategies, 3) applying problem-solving strategies, and 4) evaluating the
prablem solving that has heen undertaken

Creative thinking is fundamentally a process of producing something
original and valuable (Stenberg, 2008: 398). In general, this process follows the
stages of preparation, mcubation, intmation, illummation or msight and
venfication:

Critical thinking 15 intended 1o make logical decisions about what to
believe and what to do (Ennis, 1996). Critical thinking involves reflective and
producihive thinking, which involves evaluaton and evidence (Santrock, 2008).
Essential thinking skills which mvelve in entical thinking are, for example,
interpretation, analysis, inference, evaluation, explanation, and metacognition
According to Ennis (1996), critical thinking skills can be applied to assist in
analyzing cnucally conclusions and reasons, credibility of source, observations
made, logic taken, expenments, arguments in writing, generalization, decisions
taken. and definitions.

On the basis of what is suggested by Sanwock (2008), solving the problem
15 to find the night way to achieve a goal. While Reed (Stenberg, 2008) states that
solving the problem is an attempt to overcome the obstacles that impede the path
to the solution. According to Presseisen (1985), problem solving applies the basic
thinking to solve & difficulty that 15 unknown or undefined, assemble facts about
the difficulties and find additional information needed, make inferences or suggest
alternative solutions and test them for compliance, simplify the explanation and
eliminate mismatches, provide solubions for checking the values that can be
generalized Based on such understanding it can be concluded that solving the
problem is a cognitive process that is used in an effort 10 find the night way to
achieve a solution. The word "effort” m this definition implies that problem
solving is a process that follows the general pattern (heuristics) or follows certain

steps (algorithmic).

cd-t [pl:_l: References 777

Comment [p4]: Add o discusmn about aromive
thingking

mwuﬁmuhmqw
date

Comment [p&]: |« here any aliemative
referemeen ]

Comment [p7]: References should be more up 10
A



3

The steps that musi be taken o solve the problem according to Brasford
and Stein (in Santrock, 2008) mclude: finding and understanding problems,
develop problem-solving strategies well, exploring solutions, and thinking and
redefining the problem and the solunon from ume to nme Adair (2007)
summarizes the steps into the following stages: defining problem/goal, resulting
in the possible options, and choosing the most optimal sohition. Pretz et al (2003)
stated that the problem solving process i1s considered a cyclical process
comprising several stages: recognizing or identifying problem, defining or
conceptualizing problem, develop strategy to solve problem, organize knowledge
about problem, allocate mental and physical direct resources toward problem
solving, monitoring progress toward achieving goal state, and evaluating goal
state for accuracy. The cyele is desenptive and does not imply that all of the
problem solving proceeds sequentially through all stages in that order, however,
successful problem solvers are those who are flexible. A vanety of studies suggest
that successful problem sohing relies on a combination of domains, such as
knowledge strength, knowledge, problem-solving strategies, and self-confidence
(Lorenzo, 2003).

Smaldino el al. (2008) suggest that the instructional tools (instruction/
learning matenals) are "the specific ttem used with a lesson that influences student
leaming”. While NCVER-NCCBT cites that instructional tools is all kinds of
materials used 10 help teachers/lecturers/instructors in delivering the lesson They
can be written or non-written matenials. On the basis of the previous defimtions,
books and student activity sheets (MFIs) are including i learming tools.

From the perspectives of the course, problem solving skills can be trained
through various relevant subjects. Learming that integrates high-level thinking
skills are not easy, both in terms of planning and implementation (McGregor,
2007).

This study developed learning tools for Home Economics in the Home
Feonomic Depariment of Faculty of Engineening of Surmabava State University
{Unesa) for the learning of Food Preparation course. This gives the students o
basic understanding of the backzround of Home Economics, issues related to the
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family and how to achieve the family welfare, and as well as the scholarly study
of Home Econonuces itself

The research problems are: 1) how 1s applicability of the course plan unit?
2) how are the students’ activities during the learning process when applying the
learning model? And 3) how are the students’ problem solving skills after learning
process’

Method

The present research was a descriptive study on the implementation of the
Home Econommes leammy tools for the students to boost their problem solving
skills. The products are: 1) Cowrse Umit Plans SAP, and 2) assessment for
learning, and problem-solving skills.

This research was carmed out a1 the Home Economics Depantment of
Faculty of Engineenng of State University of Surabaya The research was
conducted from March to December 2015 The targets of the this study are
problem solving learning tools of Home Economics course.

The data required and obtained in this study were 1) the applicability of
the course plans, 2) learming activities that tran the students® thinkmg skills by
applying problem solving learming model: and 3) the problem salving skiils,

The research instruments employed in this study were 1) Observation
Sheet of Student Activities, and 2) subjective tests for problem solving as well as
their assessment rubric,

The data collection methods used i this research were. 1) observation
canducted to obtain data of and activities that enable the students to practice
their thinking skills of problem solving in applying the learning model; and 2)
Tests performed 10 obtain data of the students” problem solving performances.
The data were then analyzed by using descriptive statistics.

The observational data of the applicatility of learning activities were
analyzed by calculating the total values of all observers then calculatmg the
average of ratings for each stage of learning The resulted average of the ratings of
each stage of learning activities was further interpreted according 10 Table 1
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Tabel 1 Likert Scale Criteria

| Scores | Categories
4 | Verygood
a | Good
2 Faur
I | Poor

(Adapted from Likert Scale: Riduwan, 2012)

The percentage of activities recorded on the observation sheet is calculated
with the following formula.
Percentage of the students'activities = %x 100%
Notes:
A =L frequency of the observed leaming activities
B = L total of frequency of the activitics

Furthermore, the observation of student activity obtained during the
learning was interpreted according to Table 2 below.

Tabel 2 Scores for Imterpretation of Students™ Acuvities

Average Scores (%)  Categories
0-20 poor
2140 fanr
41-60 average
61-80 good
81-100 excellent

(Adapted from Likert Scale: Riduwan, 2012)

Furthermore, the students™ problem solving skills were determined based
on the student test results comprising pre-tests and post-tests. The results of both
tests were used to deternune the N-gain score which s represented an increased
level of the students’ problem solving skills. The qualitative descriptive analysis
was conducted to determine the leaming outcome (Hake, 1999) with the following
formula.
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{g} -, Spmr = Spr:
Smax — Spre

Notes:

<g> = pain scores (improved students” learning outcomes)

Spoa = POt fest scores

Spe = pre resi scores

Spmk = MAXIMUM SCOTES

The N-gain revealed the difference i mastering or understanding before

and after the treatment The N-gaw criteria according to Hake (1999) fall into
three categories, they are

1) If <g>>.7 categorized the leaming with high gain.

2) IF.7 »<g>> 3 categorized the learning with average gain.

3) If <g=>< 3 categonzed the leaming with low gain.

Result and Discussion
The Qbservational Data of Applicability of Learning

Observations conducted to determine the teaching and learning activities
duning the leammg process Based on the observahons, the activities were n
accordance with the stages of the cooperative leaming and problem-based
leaming models. Dunng the observations, the lecturer in charge of the course
served as observer during the learning process, assisted by one peer observer

peers. The results of the applicability are presented in Table 3.

Tabel 3 Results of Applicability of Course Unit Planning

No, Phases Average Categories
1 Communicating the course objectives IT5=94% | Very gonxd
and stumulatng the student mierest

Delivening mformotion 335=87.5% | Very good
Orgainirmg students into study groups 4=100% | Very gond

Bak | Bl

4 Scaffolding the group tasks and T 383=97% Very good
leammg
5 Assessment i=78% | Good

Giving rewards 4=100% | Very good
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Based on the phases as presented in Table 3, the applicability of the
learming model was considered as “very good”, the percentage of kthe
applicability gained 100 which mean that all the leaming activities were
implemented. All the activities carried out belonged to the category of "very
rood®, but the student presentations fit into the category of "good"

At the first meeting, there were still problems in investigating of the il
define due to lack of clarity of the lecturers’ direction to the students, 1t resulted n
the students” reduced level of understanding In addition, the students were not
familiar with the leaming method applied leamning, particularly the
Students Worksheet to train the problem solving skills. At later meetings, the
positive changes were very considerahle observed That was an excellent situation
among students, and the students with the lecturer. The students were getting used
to the applied learning during the lesson. The lecture’s class managements at the
following meetings were also good They were getting increased from the first 1o
last meeting

The Observativnal Data of Students® Activiries
The observation results related o the students’ activities in each meeting
are presented in Figure 1 below

» Percentage of
Meeting 1

Meeting 2
¥ Percentage of

0 20 40 &0 80 100
From Figure 1 it reveals that the aspects which improved in each meeting
were contributing 1deas and caring, whereas the other aspects showed similar
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results in several meetings Based on the calculation of the results of student
activity observation as a whole, it also obrained the percentage of each aspect
that can be seen in Table 4 as follows.

Table 4 the Observation Results of Student Activities

| Aspects assessed | Percentage | Categories |  N-Gain |
| Cooperative 50 85 0.7
| Contributing ideas 49 83 0.67
Responsible 50 79 0.58
Caring 60 86 0.65

From Tabel 4 sbove, it indicated that three aspects of the students’
activities were included in the “average’ category. and one aspect, ie
cooperafive was categonzed as “high'. At first meeting of the students were
still perplexed when applving the learning which trains their problem solving,
particularly i contnbuting ideas. Tlus was because the students were not used
to leaming that involved the students’ active participation to understand a
concepl by providing authentic questions referring to the learning objectives

without many interventions from the lecturer. Comment [p18): Meass give mothor mesning, do
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are only given material or new concept then questions and examples relevant
to the concept that had been discussed. In addition, the students did not get
used to learming in groups, discussing and exchanging 1deas with the other
members of the same group as well as presenting the results of their
discussion. This did not enable the students to coordinate well with the group
members. Therefore, the first meeting was not running optimally. It got worse
since the students were all individualists. However, at the second and third
meetings, the student activibes and interactions gradually improved, the
learning objectives were well achieved The students’ enthusiasm emerged at
the third meeting as the students really understood the rules of problem-based.

Data of Pretest dan Postest
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Before conducting the study. the researchers admimstered a pretest to
determine the initial ability of the studenis. The pretest results are shown in Table
4 below.

Table 4 The Pretest Results

o ~ Data . Secores

| Maximum scores 54

| Minimum scores | 32

Mean - )
Median 47
Modus 49
Standard Deviation | 5.331

The results in Table 4 reveal that the maximum score of the pretest results
was 54 and the mimimumone was 32 The mean was 45.82 and the standard
deviation was 5.331, whereas the median was 47 and the modus was 49,

In addition to the pretest, the students’ initial problem solving skills were
classified into several categones The perceniage of the students’ levels of mnitial
problem solving can be seen in Table 5.

Table 5 The percentage of the students” levels of initial problem solving

Categories for level of initial problem | N Percentage (%)
_ solving o
Verylow | 30 | 45 |

Low | 24 | 36
Average Y 19
Hi 0 0
Very high 0 0

Notes: N = the number of students in each category

Table 5 shows that the categories of the students' levels of initial problem
solving were quite diverse. Qut of 67 students, 45% of the results were
categorized as ‘very low’, 36% was in the lower category, and 19% was in the
average or medium eategory. This means that the students were still m the
learning process so it was necessary 10 apply the learning model that was able to
stimulate in order to perform problem solving.

After the implementation of learning activities formulated in the leaming
tools n the form of Student Worksheet (MFIs) and tests, the evaluation was
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administered to find out the increase of the student leaming outcomes in the form
of post-test. The postiest results can be seen in Table 6 below,

Table 6 The Posttest Results
| — Data |  Scores
 Maximum scores . 84
_ Minimum scores B il
Mean 7407
Median 77
' Modus 79
' Standard Deviation 9 (24

Based on the resulfs of students’ posttest, the highest score was 84 and the
lowest one was 55. The average score was 74 07, the standard deviation was
9.024, the mean or median was 77 and the mode value was 79.

The percentage of the students’ levels of initial problem solving can be

seen m Table 7,

Tabel 7 The percentage of the students’ levels of imtial problem solving

Categories for level of initial problem N Percentage (%)
solving i | ol
 Very low . e | 0
| Low 3 4
Average 15 22
High 26 39
Very hugh 23 34

Notes N = the number of students n each category

Table 7 gbove shows that out of 67 students, none of the students were
included n the ‘very low’ category, 4% in the ‘low’ category, 22% in the
‘medium’ category, 39% m the 'lugh’ category, and 34% a very high category.

Calcnlation of N-Gain

The improved problem solving process that the students had expenienced
can be seen from the N-gain average value of 0.577. This value is included in the
‘medium’ category. Table 8 descnibes the results of N-gain
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Table 8 The results of N-Gain

~ Data B Pretest | Postest N-Gain
Maximum score 54 84 L 0652
Mimmum score A% 55 | 0338

Mean 4582 74,07 0.577

Based on the calculation of N-gain, 4 0342% or 3 students were included
in the low category. 22% or 15 students the medium category, 39% or 26 students
in the high category and 34% or 23 swdents in the very high category. This
indicated the significant increase in problem solving aspects m which students did
after experiencing the problem-hased learning model

The results of problem-solving test data (pretest and posttest) were
obtained in accordance with the achievement indicators as described in Table 9

below

Table 9 Percentage of Indicators of Problem Solving Indicator
Achievement

I Problem Solving Indicators Pretest | Postest N-Gain

| Understanding problem 1] 79 0.764

Planning problem solving 49 Bl 0627

i_ili:ph:rrw:mm‘g the planning of S0 Fi .58

I problem solving

' Reviewing the problem solving 51 Bl 0.707

From Table 9, the percentage of indicators of understanding the problem
before treatment was 41%, and increased to 79% wath N-Gain 0.764 which was
included in the high category. The indicators of planning problem solving before
treatment was 49%, and increased 1o 81% with N-Gain 0.627 which was included
mn the medium category. There was an increase also in the indicators of
implementing the planning of problem from 50% to 79% with N-Gain 0.58 which
belonged to the medium category. The similar results occurred to the indicators of
reviewing the results of solving the problem, before treatment and after treatment,
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re. 51% to 81%, with the N-Gain of 0707 which was mcluded m the high
category

The Student worksheets (MFI) were applied and that was regarded as one
of the factors that playved a role in increasing the students’ problem solving skills.
This 15 because the MF] developed had guided the students to practice problem-
solving skills, including understanding the problem, planning problem solving,
implementing problem-solving, and reviewing the results of troubleshooting The
MFi provided the students with opportunity 1o define a problem through the
phenomenon presented at the MFL Afterwards, they should investigate the
components of the problem. After these stages, the students would be able 0 note
down passible solutions 1o these problems by synthesizing theory and practicality
in accordance with these problems, afterwards, determine a solution or a most
relevant plan to solve the problem. In the final stage the student should be capable
of executing/implementing the plan correctly, then evaluating the implementation.

This fact is adherent to the explanation of Presseisen (1985) that problem
solving apply the basic thinking skills to solve an unknown or undefined
difficulty, collect facts about the difficulty and find necessary additonal
information, make inferences or suggest alternative solutions and test them for
compliance, simplify explanations and eliminate mismatches, provide solutions
for checking the values that can be generalized In addition, the stages of the MFI
activity were also in hne with Pretz et al. (2003), stating that problem-solving 15
considered a cyclical process compnsing several steps. The cycle consists of 1)
recognizing/identifying the problem. 2) defining and representing the problem
mentally, 3) developing a solution strategy, 4) organizing knowledge about the
problem, 5) allocating resources for solving the problem, 6) monitonng progress
toward the goals, and 7) evaluate the solution for accuracy.

The second factor affecung the increase significantly in problem solving
skills was the two learning models applied in this learning, i.e. the problem-based
and cooperative leaming models Both maodels contamed positive elements that
were capable of enhancing the problem solving skills. The first element of the
problem solving skills was the swdents” leaming of concepts through discussion.
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Arends (2004, p. 427- 428) has suggested that the discussion (language expressed)
provides information about what the student already knows to create new
knowledge, 1t 1s therefore able 10 encourage cognitive development. Some studies
also revealed that the objective of the learmning of concept and performance was
associated with the use of active learning (Midgley, Kaplan and Middleton, 2001)
In addition, the students learnt concepts in groups. Wentzel cited in McInerney
and Mcinerney (2010, p. 247), Joyce and Weil (1992, p. 32) figured out that the
group work improved the learner achievement through three different ways. They
were of improving attention, mutual help, and responsibility. The second positive
was that bot models started with the presentation of a phenomenon revealing
problems for the students to solve. Based on the previous discussion, MFI and the
applied leaming model accommodated students to a higher level in the
involvement of the problem solving process so as 1o make the students tramed 1n
solving more complex problems in real contexts in accordance with the authentic

problems in real life.

Conclusion and Suggestion

Based on the results of the study 1t can be summanzed as follows: 1) all
the learning activities formulated in the Course Planning Units were satisfactorily
uptaken, The implementation of the aclivities was categonzed as "very good”, the
student presentations fit into the “good™ category ; 2} The student activities,
covering working together, contributing ideas, being responsible, and bemng cared
increased by N-consecutive gans: 0.70; 0.67. 058, and 065; 3) The
implementation of the learning tools could improve the problem solving skills of
students involves understanding the problem, planning problem solving,
implementing problem-solving, and reviewing the results of solving problems by
a number of N-gains by 0.764; 0 627; 0.580; 0.707

Therefore suggestion implied in this study is that the students’ course book
developed in this instance only measured the level of intelligibility on a small

mlpnl:(_'nmlm-huilmnf
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scale, therefore it needs to be studied further on the implementation of the course
book "Learning for Solving Problems" on a wider scale.
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UNIVERSITAS NEGERI SURABAYA TAHUN 2014
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Lampiran 4

Bukti Proses Review dan Revisi untuk Artikel Berjudul: “Developing Creative Thinking Skills in Learning
at Higher-Educational Institution of Teacher”, yang dimuat di Prosiding Seminar Internasional TVET.



«r"'-f'*" on Technical and Vocational Education and Training

—'_h_m Flemanal | 3™ UPI International Conference
-’pl'
Bandung, 13-14 November 2014

Luthfiyah Nurlaela

Dear Authors,
We thank you for participating and presenting your paper in the 3™ UPI TVET Conference. We
congratulate you that your paper entitled:

“Developing Creative Thinking Skills in Learning at Higher-Educational Institution of Teacher”

is selected ta be included in the Advances in Social Science, Education and Humanities Research series.
The Proceedings will be published by Atlantis Press, be open access, and be indexed in CPCI (Conference
Proceedings Citation Index) of Thomson Reuters and Fl/Compendex or Scopus, Google Scholar-indexed
proceedings.

In this regard, we ask you to revise and reformat your paper in accordance with the required format.
Any failure to follow the format and guidelines may cause reconsideration for the publication, We also
require you to fulfill the following recommendations:

1.
2.

M~

oA W

.~

Your name should be written without title.

The article should include: a 150-word abstract, introductian, method, result and discussion, and
conclusion,

Abstract should contain the following informations: objective/rationale, method, research
results, and their implications.

Title should not use abbreviations. All abbreviations and acronyms should be written out in full
in the title and the first time they are used on a page.

Please check your English, particularly the grammar, speliings, and punctuations, throughout.
Please enrich your references with international journal articles.

The article is saved in Word 2003 Document.

The format should follow the template, which can be found at:
http://www.ieee.org/conferences events/conferences/publishing/templates.html

The article should not exceed 6 (six) pages of A4,

Please name your article in the following format: TVET2014_First Author's Name+Second
Author’s Name.daoc (example: TVET2014_HasanudinKhan+RenataHolod.doc),

In accordance with our previous agreement, you are also required to pay an IDR 1.000.000,00
publication fee, to be transferred to the following bank account:

Account Haolder - [sma Widiaty

Account No : 0329887385

Bank : Bank Negara Indonesia (BNI) Branch: Perguruan Tinggi Bandung, Bandung.

The revised and formatted article and the proof of payment should be sent to the conference
committee’s emall: tvetconference@upi edu no later than Sunday, 1 February 2015 at 24.00. Late
articles and proof of payment will not be considered for publication.




We are looking forward to publishing your article in the Advances in Social Science, Education and
Humanities Research series.

Kind Regards,

Editors

Dr. Ade Gafar Abdullah
Tutin Aryanti, Ph.D.
Dr. Phil. Dadang Kurnia
Dr. Siscka Elvyanti



Paper Title* (use style: paper title)

Subtitle as needed (paper subtitle)

Authors Name/s per 1st Affiliation (Author)
line 1 (of Affilietion). dept. name of orgamzation
line 2-name of organization, acronyms acceptable
line 3-Citv, Country
line 4-g-mail address if desired

Abstract—This electronic document is a “live™ template and
already defines the components of your paper [title, text, heads,
elc.] im its style sheet

(Abstracr)

:gnmn{s—cmpwm; Sormatting: style; styling; invert (hey
war

[ INTRODUCTION (HEADING 1)

Thas template, modified in MS Word 2007 and saved as a
“Word 97-2003 Document” for the PC, provides authors with
most of the [ormating speafications needed for prepanng
eleclronic  versions  of Lheir papers. All standard
componenis have been specified for three reasons, (1) ease of
use when formatting individual papers. (2) automatic
compliance lo electiromc requirements thal facilitate the
concurrenl or later production of electronic products, and (3)
conformitv of stvle throughout a conference proceedings.
Margins, column widths. line spacing. and type styles are built-
i, examples of the type styles are provided throughout this
documeant and are identified in italic type, within parentheses,
following the example Some components, such as multi-
leveled equations, graphics, and tables are not prescnbed,
although the vanopus table text stvles are provided The
formatter will need to create these components, mcorporating
the applicable criteria that follow.

II. EASE OF Usr

A Selecting a Template (Heading 2)
First, confirm that you have the comrect template for vour
paper size. This template has been tailored for output on the A4

paper size. Il you are wsing US letter-sized paper, please close
this file and download the file “MSW_UShr format”

B Maintaining the Integrity of the Specifications

The template is used to format your paper and stvle the texi.
All margins, column widths, line spaces, and text fomis are
prescribed: please dc not alter them You may note
peculiariies. For example, the head margn in tus templaie
measures proportionately more than is customary. This
measurement and others are deliberate, using specifications
that anticipute vour paper as one part of the entire proceedings,

Identafy apphicable .qnn‘imhh:ﬂ. M no sponsors, delete this text box
{spioraseirs),

Authors Name/s per 2nd Affiliation (Author)

line 1 (of Affihation). dept. name of organization
line 2-name of organization, acronyvms acceptable
line 3-City, Country
line 4-e-mail address il desired

and not as an independent document. Please do not revise any
of the current designations.

L PREPARE YOUR PAPER BEFORE STYLING

Before vou begin 1o format vour paper, first write and save
the content as a separate text file. Keep vour text and graphic
files separate until afler the text has been formatted and stvied
Do not use hard tabs, and limit use of hard returns 10 only cne
refun al the end of a paragraph Do not add anv kind of
pagination anywhere in the paper. Do not number text heads-
the template will do that for you.

Finally, complele content and organizaional ediung before
formattmg  Please take note of the following items when

proofreading spelling and grammar:

A, Abbreviations anid Acronvmy

Define abbreviations and acronyms the first ume they are
used in the text, even afler they have been defined in the
abstract. Abbreviations such as IEEE, SI. MKS, CGS, sc, de,
and rms do not have 1o be defined Do nol use abhrevialions in
the title or heads unless they are unavoidable,

B. Unirs

= Use either SI (MKS) or CGS as primary units. (81 units
are encouraged ] English uniis may be wsed as
secondary units (in parentheses). An exception would
be the use of English umis as identifiers in trade, such
as “3.5-inch disk dnive ™

=  Avoid combining S1 and CGS wmts, such as current in
amperes and magnetic field in oersteds. This ofien leads
o confision because eguations do not  balance
dimensionally. If vou must use mixed units, clearly
state the units for each quanuty that vou use in an
ajuation.

= Do not mix complete spellings and abbreviations of
units: “Wh/m2” or “webers per square meter,” nol
“webers/m2.” Spell units when they appear in text “ a
few henries,” not *_.a few H.”

* Usea zero before decimal points: “0.25,” not “ 25~ Use
“em3.” not Ve " (bullet fisr)



" Egquations

Thz equations are an exceplion (o the presenbed
specifications of this template. You will need 10 determine
whether or not vour equation should be typed using either the
Times New Roman or the Symbol font (please no other font).
To create multileveled equations, it may be necessary 10 treat
the equation as a graphic and insert it info the text after vour
paper is styled.

Mumber equotions consecutively. Equation numbers, within
parentheses. are to position flush right, as in (1), using a right
tab stop. To make vour equations more cOMpPAacy you may use
the solidus ( / ). the exp Function, or approprate exponents
italicize Roman symbols for quantities and vanables. but not
Greeh symbols Use a long dash rather than a hyphen for a
minus sign Punctuate equations with commas or periods when
they are part of a sentence, as

a+b =y (1)

Note that the equation is centered using a center tab stop.
Be sure that the symbols m your equation have been defined
before or immediately following the equation. Use (11" not
“Egq. (10" or “equation (1),” except al the begmning of a
sentence “Equation (1) 15 .7

1. Some Common Mistakes
¢ The word "data”™ 15 plural. not singular,

* The subscript for the permeability of vacuum g, and
other common scientific constants, i5 zero with
subscrpt formatting, not a lowercase lefter "0

s In American English, commas, semi-/colans. periods,
question and exclamation marks are located within
quotation marks only when a complete thought or name
15 ciled, such as a utle or [ull guotation. When quotation
marks are used. instead ol a bold or italic typeface, 10
highlight a word or phrase, punctuation should appear
outside of the quotation marks. A parenthetical phrase
or stalement at the end of a sentence is punctuated
outside of the closing parenthesis (like this). (A
parenthetical  sentence 18 puncluated within  the
parentheses, )

= A graph within & graph is an “mnset,” not an “mnsert”
The word alternatively is preferred to the word
“altemnately” (unless vou really mean something that
aliernates).

= Do not use the word “essennaly”
“approximately” or “effectively ~

= In vour paper title, if the words “thal uses™ can
accurately replace the word using, capitalize the “u”, if
not. keep using lower-cased

0 mean

* Be aware of the different meanings of the homophones
“affect”™ and “efTect,” mmplamenl and “compliment.”
“discreet” and “diserete,” “principal” and “principle. "

* Do not confuse “imply™ and “infer. "

s  The prefix “non” 15 not a word. it should be joined to
the word it modifies, usually without a hyphen

e There is no period after the “et” in the Lotin
abbreviation “et al.”

¢ The abbrewiation “ie” means “that is~
abbreviation “e g~ means “for example ”

and the

An excellent styvle manual for science writers 15 | 7]

IV, USING THE TEMPLATE

Aliter the text edit has been completed. the paper is ready
for the tlemplate. Duplicate the template file bv using the Save
As command, and use the naming conveniion prescribed by
vour conference for the mame of your paper. In this newly
created file, highlight all of the contents and import vour
prepared lext file. You are now ready 1o style vour paper, use
the scroll down window on the left of the MS Word Formatiing
toolbas. a+f =1 (1 (n

A. Authors and Affiliations

The template is designed so that author affilations are not
repeated cach ume for multiple authors of the same affiliation
Please keep vour affiliations as succinct as possible (for
example, do not differentiate among departments of the same
organization). This template was designed for two affiliabions

1} For author's of only one affiltation (Heading 3). To
change the default, adjust the template as follows.
a) Selechon (Heading 4): Highlight all author and
affiliation lines
b) Change number of colummns Select the Columns 1con

from the MS Word Standard toolbar and then select “1
Column™ from the selection palette

¢) Deletion: Delete the author and alfihation lines for
the second affiliation.
2) For author's af more than two affiliations:
the default, adjust the template as follows.
a) Selection. Highlight all author and affiliation hines.

h) Change number of columns Select the “Columns™
icon from the MS Word Standard toolbar and then select |
Column” from the selection paletie.

¢) Highlight author and affiliation lines of affiliation |
and copy this selection.

) Formaning. Insert one hard return immediately after
the last character of the last affiliation line Then paste down
the copy of affiliation | Repeal as necessarv for each
additional alTihation.

¢) Reassign number of columns: Place vour cursor 10
the nght of the last character of the last affiliabon hine of an
even numbered affiliation (e 2. if there are five affiliations,
place your cursor at end of fourth affiliation). Drag the cursor
up to highlight all of the above author and aMiliation lines. Go
10 Column icon and select “2 Columns™ If vou have an odd

To change



number of affilations, the final afMiliation will be centered on
the page, all previous will be in two columns

B, Kientify the Headings
Headings, or heads, are orgamzational devices that guide

the reader through your paper, There are two types: component
heads and text heads.

Component heads ideniify the difTerent componenis of vour
paper and are not topically subordinate to gach other. Examples
include ACKNOWLEDGMENTS and REFERENCES, and for
these, the correct siyle 1o use is “Heading 5. Use “figure
caption” for your Figure captions, and “table head™ for vour
table title. Run-in heads, such as “Abstract,” will require you 1o
apply a style (in this case, italic) in addition to the shie
provided by the drop down menu to differentiate the head from
the text

Text heads organize the topics on a relational, hierarchical
hasis For example, the paper title is the pnmary text head
because all subsequeni material relates and elaborates on ths
one topic. If there are two or more sub-topics, the next level
head (uppercase Roman numerals) should be used and.
conversely, il there are not at least two sub-topics. then no
subheads should be inroduced. Styles named “Heading 1.”
“Heading 2,” “Heading 3,” and “Heading 4" are prescrnibed

" Figures and Tables

1) Posinoming Figures and Tables: Place fipures and
tables at the rop and bonom of coluemns. Avold placing them in
the miuddle of columns. Large fipures and rables may span
across hoth columns. Figure captions should be below the
figures: table heads should appear ahove the tables Insert
figures and tables afier they are cired in the text [se the
abbreviation "Fig. 1" even ar the beginning of a sentence.

TABLE L TABLE STYLES
Tahle Table Column Head
- Head | Table column subhead

copy | Muome table copy® |

* ampile 54w Tubls fostraste. (Tably faotmats)
[%

We suggest (hal vou use a lexl box to insert a graphic
(which 15 ideally a 300 dpi resolution TIFF or EPS file with
all fonts embedded) because this method 1s somewhat more
stable than diractly inserting a picture.

To have non-visible rules on vour frame, use the
MSWord “Format™ pull-down menu select Text Box >

Colors and Lnes 1o choose No Fill and Na Line

Fig 1. Example of a figore caption. (figure caption)

Figure Labels: Use 8 point Times New Roman for Figure
labels Use words rather than symbols or abbreviations when
writing Figure axis labels to avoid confusing the reader. As an

example, wnte the quantitv “Magpetization,” or
“Magnetization. M,” nol just “M.” Il including umits in the
label, present them within parentheses Do nol label axes only
with umits. In the example. write “Magnetizaton (A/m)” or
“Magnetization (A { m{1),” not just “A/m.” Do not label axes
with a ratio of quantibes and units For example, wriie
“Temperature (K),” not “Temperature/K. ™

ACKNOWLEDGMENT [(Heading 5)

The preferred spelling of the word “acknowledgmen!™ mn
America s withoul an “e” afler the “g” Avoid the stilted
expression “one of us (R B G) thanks = 7 Instead, iy "R B
G. thanks. ™ Put sponsor acknowledgments in the unnumbered
footnote on the first page.

REFERENCES
The template will number citanons consecutively within
brackets | 1] The sentence punctuation follows the brackel |2]
Refer simply to the reference number, & in [3]—do noi use
“Ref [3]" or “reference |3]" except at the beginning of a
sentence’ “Reference 3] was the first . ™

Number foolnotes separately 1n supersenipts  Place the
actual footnote at the bottom of the column m which it was
cited Do not put footnotes in the reference list. Uise letters for
table footnotes.

Unless there are six authors or more give all authors’
names; do not use “ef al = Papers that have not been published,
even if thev have been subnmuited for publicaton, should be
cited as “unpubhshed™ |4] Papers that have been accepted lor
publication should be cited as “in press” [3]. Capitalize only
the first word i a paper nitle. except for proper nouns and
element symbols.

For papers published in translation journals please give the
English citation first, followed by the oniginal foreign-language
citation [6]

[1] O Esson, B. Moble, and [N Sneddon, “Un certuin wlegrals of
Lipschitz-Huankel tvpe involving products of Bessal fmctions,” Phil
Trans. Koy, Soc. London, vol. A247, pp 522551, Apnl (955
{references)

[2] J Clerk Mawwell, A Tocatise on Flectricity and Magnetism, 3nd ed | vol
2 Oxdord: Clarendon, 1892, pp 68-73

[3] IS, Jacobs and C.P Hean “Fine particles, fhin films and exchange
unizotropy,” in Mognetism, vol. I, G T Rado and H. Suhl, Fds. New
York: Academic, 1963, pp. 271-350

[4] K Elissa “Title of pape if known,” npublished

|5] R MNicole, *Title of paper with only first word capilalized " 1 Name
Stand. Abbrev., in pres.

6] Y. Yoron, M. IGirane, K. Ok, and Y. Tagawa, “Lleciron spectroscopy
studiex on magneto-optical media and plastic substrute interface. " IEEE
Transl 1. Magn Japan, val 2, pp T Avgusi 1987 [Digests 9th
Annual Conf. Magnetica Japan, p 301, 1952

[ M Youmg The Techmecal Wnter's Handbook Ml Valley, CA
Umiversity Science, 1989



Lampiran 5

Bukti Proses Review dan Revisi untuk Artikel Berjudul: "Interactive Multimedia-Based Learning to
Improve Students’ Creative Thinking Skills”, yang dimuat di Prosiding Seminar Internasional TVET.
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4™ UPI International Conference Pl intemational |
on Technical and Vecational Education and Training Conferance on |
Bandung, 1 5-16 Noverrber 2014 v TVET

Bandung, 8 September 2016

To : Yuwun Irawati
Luthfiyah Nurlaela
Meda Waohini

Dear Authors,

On behalf of theOrganizingCommitee of 4™ UPI International Conference on
Technical and Vocational Education atthe Indenesia University of Education
(UP1), we are delighted to inform that your abstract entitled:

“Interactive Multimedia-Based Learning to Improve Students Creative Thinking
skills)”

has been accepted for presentationat the 4™ UPI International Conference
on Technical and Vocational will be held on 15-16 MNovember 2016 in
Bandung, Indonesia.

Please submit your full paper at the conference website by 20 September
2016. The full paper should follow the assigned poper template.

We look forward to receiving your full paper.

Chair,
4" UPI International Conference on TVET

“Pl International
Cmﬂemme on

TutinAryanti, Ph.D.
NIP. 15750815 200312 2001
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Preparing a two column paper with MS Word for Windows

A.T. Balkema & G. Westers
A.A. Balkema Publishers, Rotterdam, Netherlands

B. Unknown
New Institute, Gouda, Netheriancs

ABSTRACT: Authors of papers o proceedings have 1o type these in a form suitable for direct photographic
reproduction by the publisher. In order to ensure uniform style throughout the volume, all the papers have to be
prepared strictly according to the instructions set below. The enclosed CP1_AR_PDF1.7 joboptions should
be used to create the final Camera Ready Copy PDF file. The publisher will reduce the camera-ready copy
to 75% and print it in black only. For the convenience of the authors template files for MS Word 6.0 (and

higher) are provided.

| GENERAL INSTRUCTIONS
1.1 Tvpe area

The text should fit exactly into the type area of 187 x
272 mm (7.36" x 10.71"). For correct settings of
margins in the Page Setup dialog box (File menu) see
Table 1.

1.2 Twpefont, typesize and spacing

Use Times New Roman |2 point size and 13 point
line spacing (Normal:text tag). Use roman tvpe
except for the headings (Heading tags), parameters in
mathematics (not for log, sin, cos, In, max., d (in dx),
ete), Latin names of species and genera in botany and
zoology and the titles of journals and books which
should all be in italics. Never use bold, except to
denote vectors in mathematics, Never underline any
text. Use the small font (10 pownts on 11 points) for
tables (Table tags), figure captions (Figure caption
tag) and the references (Reference text tag).

Never use letterspacing and never use more than
one space after each other.

2 GETTING STARTED
2.1 Preparing the new file with the correct template

Copy the tremplate file B2ProcA4.dot (if you print on
Ad size paper) or B2ProcLe dot (for Letter size paper)
to the template directory. This directory can be found
by selecting the Tools menu, Options and then by
tabbing the File Locations, When the Word
programme has been started open the File menu and
choose New. Now select the template B2ProcA4 . dot

or B2ProcLe.dot (see above). Start by renaming the
document by clicking Save As in the menu Files.
Name your file as follows: First three letters of the file
name should be the first three letters of the last name
of the first author, the second three letters should be
the first letter of the first three words of the title of the
paper (e.g. this paper: balpat.doc). Now you can type
your paper, or copy the old version of your paper onto
this new formated file.

2.2 Copying old iext onio new file

Open your old file and the new file. Switch between
these two with the Window menu. Select all text of
the old fle (excluding title, authors, afTiliations and
abstract) and paste onto bottom of new file. after
having deleted the word INTRODUCTION (see also
section 2.5). Check the margin setting (Page Setup
dialog box in File menu) and column settings (see
Table 1 for correct settings). After this copy the texts
which have o be placed in the frames (se¢ sections
2.3 and 2.4 ). In order 0 avoid disruption of the text

Table |. Margin settings for A4 size paper and letter
size paper.

Setting Ad size paper Letter size paper
cm inches cm inches

Top 12 047 032 013"
Bottom 1.3 ns|" D42 017
Lefi 1.15 045" 145 057
Right 1.15 045" 145 057
All other 0o 0o" 0.0 uo”
Column width* 9.0 3547 0.0 354"
Column spacing* 0.7 0.28" 0.7 0.28"

* Column dialog box in Formal meniu.



and frames, copy these texts paragraph by paragraph
without including the first word (which includes the
old tag). It 1s best to first retype the first words
manually and then to paste the correct text behind.
When the new file contains all the text, the old tags in
the text should be replaced by the new Balkema tags
(see section 3). Before doing this apply automatic
formatting (AutoFormat in Format menu).

2.3 Tule, author and affiliation frame

Place the cursor on the T of Title at the top of your
newly named file and type the title of the paper in
lower case (no caps except for proper names). The
title should not be longer than 75 characters). Delete
the word Title (do not delete the paragraph end). Place
the cursor on the A of A B.Author(s) and type the
name of the first author (first the initials and then the
last name). If any of the co-authors have the same
affiliation as the first author, add his name after an &
(or a comma if more names follow). Delete the words
A.B. Author etc. and place the cursor on the A of
Affiliation. Type the correct affiliation (Name of the
institute, City, State/Province, Country). Now delete
the word Affiliation. If there are authors linked to
other institutes, place the cursor at the end of the
affiliation line just typed and give a return. Now type
the name(s) of the author(s) and after a retun the
affiliation. Repeat this procedure until all affiliations
have been typed.

All these texts fit in a frame which should not be
changed (Width: Exactly 187 mm (7.36"); Height:
Exactly 73 mm (2.87") from top margin; Lock
anchor).

24 Abstract frame

If there are no further authors place the cursor one
space behind the word ABSTRACT: and type your
abstract of not more than 150 words. The top of the
first line of the abstract will be 73 mm (2.87") fiom
the top of the type area. The complete abstract will
fall in the abstract frame, the settings of which should
also not be changed (Width: Exactly 187 mm (7.36");
Height: Automatic, Vertical 73 mm (2.87") from
margin. Lock anchor).

2.5 First line of text or heading

If your text starts with a heading, place the cursor on
the | of INTRODUCTION and type the correct text
for the heading. Now delete the word
INTRODUCTION and start with the text after a
return. This text should have the tag First paragraph.

If your text starts without a heading you should
place the cursor on the 1 of INTRODUCTION,

change the tag to First paragraph and type your text
after deleting the word INTRODUCTION,

3 LAYOUT OF TEXT
3.1 Text and indenting

Text is set in two columns of 9 cm (3.54") width each
with 7 mm (0.28") spacing between the columns. All
text should be typed in Times New Roman, 12 pt on
13 pt line spacing except for the paper title (18 pt on
20 pt), author(s) (14 pton 16 pt), and the small text in
tables, captions and references (10 pt on 11 pt). All
line spacing is exact, Never add any space between
lines or paragraphs. When a column has blank lines at
the bottom of the page, add space above and below
headings (see opposite column).

First lines of paragraphs are indented 5 mm (0.2")
except for paragraphs after a heading or a blank line
(First paragraph tag).

3.2 Heuadings

Type primary headings in capital letters roman
(Heading | tag) and secondary and tertiary headings
in lower case italics (Headings 2 and 3 rtags).
Headings are set flush against the left margin. The tag
will give two blank lines (26 pt) above and one (13
pt) beneath the pnmary headings, 1% blank lines (20
pt) above and a ' blank line (6 pt) beneath the
secondary headings and one blank line (13 pt) above
the tertiary headings. Headings are not indented and
neither are the first lines of text following the heading
indented. If a primary heading is directly followed by
a secondary heading, only a 2 blank line should be
set between the two headings. In the Word
programme this has to be done manually as follows:
Place the cursor on the primary heading, select
Paragraph in the Format menu, and change the setting
for spacing after, from 13 pt to 0 pt. In the same way
the setting in the secondary heading for spacing
before should be changed from 20 pt to 7 pt.

3.3 Listing and numbering

When listing facts use either the style tag List signs
or the style tag List numbers.

34 Equations

Use the equation editor of the selected word
processing programme. Equations are not indented
(Formula tag). Number equations consecutively and
place the number with the tab key at the end of the
line, between parantheses. Refer to equations by these
numbers. See for example Equation 1 below:

From the above we note that sin 6 = (x + y)z or;



7 ™ 4
Rt ' h
K =|1-
{ ¢, +viand ! (

where ¢, = interface adhesion; & = friction angle at
interface; and k) = shear stiffness number.

For simple equations in the text always use
superscript and subscript (select Font in the Format
menu). Do not use the equation editor between text
on same line,

The mhne equations (equations within a sentence)
in the text will automatically be converted to the AMS
notation standard.

3.5 Tables

Locate tables close to the first reference to them in the
text and number them consecutively. Avoud
abbreviations in column headings. Indicate units in
the line immediately below the heading. Explanations
should be given at the foot of the table, not within the
table itself. Use only horizontal rules: One above and
one below the column headings and one at the foot of
the table (Table rule tag: Use the Shift-minus key to
actually tvpe the rule exactly where you want it). For
simple tables use the tab key and not the table option.
Type all text in tables in small type: 10 on 11 points
(Table text tag). Align all headings to the left of their
column and start these headings with an initial capital.
Type the caption above the table 1o the same width as
the table (Table caption tag). See for example Table
I

3.6 Figure captions

Always use the Figure caption style tag (10 points
size¢ on 11 points line space) Place the caption
underneath the figure (see Section 5). Type as
follows: *Figure 1. Caption.” Leave about two lines of
space between the figure caption and the text of the

paper.

3.7 References

In the text, place the authors’ last names (without
initials) and the date of publication in parentheses
(see examples in Section 5). At the end of the paper,
list all references in alphabetical order underneath the
heading REFERENCES (Reference heading 1ag).
The references should be typed in small text (10 pt on
11 pt) and second and further lines should be indented
5.0 mm (0.2") (Reference text tag). If several works
by the same author are cited, entries should be
chronological.

Larch, A A, 1996a. Development ...

Larch, A.A. 1996b. Facilities ...

Larch, A.A. 1997. Computer ..,

Larch, A.A. & Jensen, M.C. 1996, Effccts of ...
Larch, A A. & Smith, B.P. 1993, Alpine ...

3.7.1 Tvpography jor references

Last name, First name or Initials (ed ) vear Book title. City:
Publisher.

Last name, First name or Initials year Title of article. Titie af
Journol (series number il necessary) volume number (issuc
number if nceessary): page numbers,

3.7.2 Examples

Crove, AT. 1980, Geomorphic evolution of the Sahara and the
Nile. In M.AJ. Williams & H. Foure (eds). The Sahara and
the Nife: 21-35. Rotterdam: Balkema.

Jappelli. R. & Marconi, N. 1997. Recommendations and
prejudices i the realm of foundation engmeenng m laly: A
historical review. In Carlo Viggiani (ed.), Georechnical
engineerimg  Jor (e preservation of monuments  and
historical sites, Proc. anrern. symp., Napoli, 3-4 October
{906, Rotterdam: Balkema.

Johnson, H L. 1965. Artistic development in autistic children,
Child Develapment 65(1) 13-16

Polhill, RM. 1982, Crotalaria in Africa and Madagascar.
Rotterdam: Balkema.

3.7.3 Endnote
We would appreciate it if you make use of the
enclosed Endnotes stylefile (Harvard.ens).

3.8 Nowes

These should be avoided. Insert the information in the
text. In tables the following reference marks should
be used: * ** etc. and the actual footnotes set
directly undemeath the table.

3.9 Conclusions

Conclusions should state concisely the most
important propositions of the paper as well as the
author’s views of the practical implications of the
results.

4 PHOTOGRAPHS AND FIGURES

Number figures consecutively in the order in which
reference is made to them in the text, making no dis-
tinction between diagrams and photographs. Figures
should fit within the column width of 90 mm (3.54")
or within the rype area width of 187 mm (7.36").

Figures, photographs, etc. can be in black/white or
full color, but will be produced in the book in
black/white only. Please msert the high resolution
figures (see artwork document) in the word file.
Figures, etc. should not be centered, but placed
against the left margin. Leave about two lines of
space between the actual text and figure (including
caption). Never place any text next to a figure. Leave
this space blank. The most convenient place for
placing figures is at the top or bottom of the page.
Avoid placing text between figures as readers might
not nofice the text. Keep in mind that everything will
be reduced o 75%. Therefore, 9 point should be the
minimum size of the lettering. Lines should



preferably be 0.2 mm (0,1") thick. Keep figures as
simple as possible. Avoid excessive notes and
designations.

anelsstic sinain

shiflhess decrease
in tension

cmck dosure

conpressive
vicding point

Figure | Caption of a typical figure. Photographs will be
scanned by the printer, Always supply original photographs,

Photographs should be with good contrast and
preferably in TIFF or EPS format (see Anwork
document). Photographic reproductions cut from
books or journals, photocopies of photographs and
screened photographs are unacceptable. The
proceedings will be printed in black only. For this
reason avoid the use of colour in figures and
photographs. Colour is also nearly always
unnecessary for scientific work.

5 PREFERENCES, SYMBOLS AND UNITS

Consistency of style 1s very important. Note the

spacing, punctuation and caps in all the examples

below.

— References in the text: Figure |, Figures 24, 6, 8a,
b (not abbreviated)

- References between parentheses: (Fig. 1), (Figs 2-
4, 6, 8a, b) (abbreviated)

- USA /UK / The Netherlands insfead of US.A. /
U.K. / Netherlands / the Netherlands

— Author & Author (1989) instead of Author and
Author (1989)

~ (Author 1989a, b, Author & Author 1987) instead
of (Author, 1989a b: Author and Author, 1987)

— (Author et al. 1989) instead of (Author, Author &
Author 1989)

- Use the following sivle: (Author, in press);
(Author, n prep.); (Author, unpubl.); (Author,
PErs. comm. )

Always use the official SI notations:
- kg/m/k)/ mm instead of kg. (Kg) /m. / k], (KJ)
[ mm.;

20°16'32"SW instead 0f 207 16' 32" SW

0.50 instead of 0,50 (used in French text), 9000

instead of 9,000 but if more than 10,000; 10,000

instead of 10000

— "Cinstead of C"* | C-14 and BP / BC / AD instead
of BP./BC./AD.

~ * 20 instead of x20 / X20 / x 20: 4 + 5 > 7 instead
of 4+5>7 but -8 [ +8 insteadof 8/+ 8§

- eg. lie insteadofeg., /ie,

6 SUBMISSION OF MATERIAL TO THE
EDITOR

The camera-ready copy PDF file of the complete
paper should be created with the enclosed
CPI_AR_PDF1.7.joboptions file and sent to the
editor. Together with the MsWaord or LaTeX file.
All figures should be included as high resolution file
in the PDF and word file (see artwork document).
Check whether the paper looks the same as this
sample: Title at top of first page in 18 points, authors
in 14 points and all other text in 12 points on 13 points
line space, except for the small text (10 point on 11
point line space) used in tahles, captions and
references. Also check if the type width is 187 mm
(7.36"), the column width 90 mm (3.54"), the page
length is 272 mm (10.71") and that the space above
the Abstact is exactly as in the sample. Write your
name and the shortened title of the paper in pencil in
the bottom margin of each page and number the pages
correctly

7 DEADLINE
The above material should be with the editor before

the deadline for submission. Any material received
1oo late will not be published.
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